APPLIED PORTFOLIO MANAGEMENT THEORIES WITH VBA AND EXCEL

A Project

Presented to the faculty of the Department of Business
California State University, Sacramento

Submitted in partial satisfaction of the requirements for the degree of

MASTER OF ARTS

in

Business Administration

Finance

by

Rachel Stark

FALL
2013
APPLIED PORTFOLIO MANAGEMENT THEORIES WITH VBA AND EXCEL

A Project

by

Rachel Stark

Approved by:

__________________________________, Committee Chair

Hamid Ahmadi, Ph.D.

__________________________________

Date
Student: Rachel Stark

I certify that this student has met the requirements for format contained in the University format manual, and that this project is suitable for shelving in the Library and credit is to be awarded for the project.

__________________________, Department Chair

________________________

Date

Department of Finance
Abstract

of

APPLIED PORTFOLIO MANAGEMENT THEORIES WITH VBA AND EXCEL

by

Rachel Stark

According to the modern portfolio theory, investors should not limit themselves to the expected risk and return of one particular stock. Investors should reduce risks through diversification because the risk in a portfolio of diverse stocks will be less than the risk of any one of the stocks. The key is diversification. Diversification is not as simple at owning ten different stocks, but to comprise assets that are relatively unrelated in order to mitigate risks. This is important when one sector performs poorly, while other sectors are performs well.

In classrooms, finance students learn the principles of investment analysis and investment courses cover topics of asset management utilizing Markowitz portfolio theory, Capital Market theory, and other investment strategies. However, most of these finance courses do not provide the skills you need to build these financial models for private or professional use. There are four basic steps involved to construct optimal portfolios that offer the maximum possible expected return for a given level of risk; security valuation, performance measurement, asset allocation, and portfolio optimization. By using Excel, Visual Basics for Applications (VBA), and data from Yahoo Finance, you will able to analyze and build an investment portfolio. This
document will be helpful for those who want to expand their knowledge in finance and investments analysis by implementing these theories in Microsoft Excel.

It will take time to initially set-up the spreadsheets with the desired data and entering the necessary formulas and VBA code, but once done correctly, comparing different equity securities will be relatively simple. Excel is a superb data analysis tool. Also, Yahoo Finance is a reliable source of free financial data information. It supports bulk data downloads which simplifies the task of downloading the historical financial data from finance.yahoo.com to Excel.

This document is a hands-on approach to apply complex financial theories using Excel and VBA as a medium. The following chapters are written to be purposefully easy to understand to be suitable for anyone with a basic understanding of finance and Excel. The easy-to-follow guide will effectively walk you through the process of completing various Excel spreadsheets to develop a graphical depiction of the trade-off between risk and return for an efficient portfolio.

_______________________, Committee Chair
Hamid Ahmadi Ph.D.

_______________________
Date
TABLE OF CONTENTS

List of Tables ........................................................................................................................................ vii
List of Figures .......................................................................................................................................... viii

Chapter

1. INTRODUCTION ............................................................................................................................. 1

2. VISUAL BASICS OF APPLICATION .............................................................................................. 3
   Displaying Developer Tab .................................................................................................................. 4
   VBA Reference Library ...................................................................................................................... 5
   VBA Entering and Editing Basics ....................................................................................................... 6
   VBA Windows ..................................................................................................................................... 8
   Run Macros ....................................................................................................................................... 8

3. SECURITY ANALYSES ...................................................................................................................... 10
   Financial Data Worksheet ................................................................................................................ 10
   VBA – Stock Information Macro ....................................................................................................... 11
   Results .............................................................................................................................................. 13

4. STOCK PERFORMANCE ................................................................................................................. 15
   Excel: Company Selection Spreadsheet ........................................................................................... 15
   How the Macro Works ..................................................................................................................... 25

5. SETUP WORKSHEETS .................................................................................................................... 26
   Company Selection Worksheet ........................................................................................................ 27
   Creating Labels with the Transpose Function .................................................................................. 29
Calculation Headers........................................................................................................... 31

6. ASSET ALLOCATION ........................................................................................................ 33
   Completing Calculations................................................................................................. 33
   Directions for Completing the Matrix Worksheet ......................................................... 35
   BHM Matrix.................................................................................................................... 38
   BHM\(^1\) Matrix ............................................................................................................ 39
   Investment Proportion Calculations.............................................................................. 41
   Equity Worksheet.......................................................................................................... 41
   Stocks and Bonds Worksheet.......................................................................................... 45

7. OPTIMAL PORTFOLIO ..................................................................................................... 48
   Investment Proportions Chart ...................................................................................... 48
   Creating the efficient frontier graph ........................................................................... 49
   Conclusion .................................................................................................................... 55
   Work Cited..................................................................................................................... 57
LIST OF TABLES

Tables Page

Table 1.1: Definitions ........................................................................................................3

Table 5.1: COVAR Functions..........................................................................................33

Table 5.2: Portfolio Calculations ....................................................................................37
## LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figures</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1.1: Adding Developer Tab</td>
<td>5</td>
</tr>
<tr>
<td>Figure 1.2: Developer Ribbon</td>
<td>5</td>
</tr>
<tr>
<td>Figure 1.3: Reference – VBAProject Library</td>
<td>6</td>
</tr>
<tr>
<td>Figure 1.4: VBA Module</td>
<td>7</td>
</tr>
<tr>
<td>Figure 1.5: Properties Window</td>
<td>8</td>
</tr>
<tr>
<td>Figure 1.6: Run Macros</td>
<td>9</td>
</tr>
<tr>
<td>Figure 2.1: Headers</td>
<td>10</td>
</tr>
<tr>
<td>Figure 2.2: Stock Tickers</td>
<td>11</td>
</tr>
<tr>
<td>Figure 2.3: Stock Information Data Download Macro</td>
<td>11</td>
</tr>
<tr>
<td>Figure 2.4: Run the macro</td>
<td>13</td>
</tr>
<tr>
<td>Figure 2.5: Financial Data Worksheet</td>
<td>14</td>
</tr>
<tr>
<td>Figure 3.1: Company Selection Worksheet Setup</td>
<td>15</td>
</tr>
<tr>
<td>Figure 3.2: Historical Prices and Monthly Returns VBA Code</td>
<td>16</td>
</tr>
<tr>
<td>Figure 3.3: Monthly Returns Worksheet</td>
<td>25</td>
</tr>
<tr>
<td>Figure 4.1: New Name</td>
<td>26</td>
</tr>
<tr>
<td>Figure 4.2: Name Box</td>
<td>27</td>
</tr>
<tr>
<td>Figure 4.3: Company Selection Headers</td>
<td>27</td>
</tr>
<tr>
<td>Figure 4.4: Drop Down Menu</td>
<td>28</td>
</tr>
<tr>
<td>Figure 4.5: Company Selection Template</td>
<td>29</td>
</tr>
<tr>
<td>Figure 5.6: Company Selection Results</td>
<td>29</td>
</tr>
<tr>
<td>Figures</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td></td>
</tr>
<tr>
<td>Figure 4.7: Stock Labels</td>
<td>Page 30</td>
</tr>
<tr>
<td>Figure 4.8: Capture Stock Returns</td>
<td>Page 31</td>
</tr>
<tr>
<td>Figure 4.9: Calculation Headers</td>
<td>Page 32</td>
</tr>
<tr>
<td>Figure 5.1: Covariance Matrix</td>
<td>Page 34</td>
</tr>
<tr>
<td>Figure 5.2: Calculations</td>
<td>Page 35</td>
</tr>
<tr>
<td>Figure 5.3: VCM Matrix</td>
<td>Page 36</td>
</tr>
<tr>
<td>Figure 5.4: Minimum Variance Proportions</td>
<td>Page 37</td>
</tr>
<tr>
<td>Figure 5.5: Portfolio Calculation Results</td>
<td>Page 38</td>
</tr>
<tr>
<td>Figure 5.6: BHM Matrix</td>
<td>Page 39</td>
</tr>
<tr>
<td>Figure 5.7: BHM⁻¹ Matrix Setup</td>
<td>Page 40</td>
</tr>
<tr>
<td>Figure 5.8: Completed BHM⁻¹ Matrix</td>
<td>Page 41</td>
</tr>
<tr>
<td>Figure 5.9: Equity Worksheet Headers</td>
<td>Page 42</td>
</tr>
<tr>
<td>Figure 5.10: Equity Sheet Calculations</td>
<td>Page 43</td>
</tr>
<tr>
<td>Figure 5.11: Maximum Slope</td>
<td>Page 44</td>
</tr>
<tr>
<td>Figure 5.12: Stocks and Bonds Calculations</td>
<td>Page 45</td>
</tr>
<tr>
<td>Figure 5.13: Stocks and Bonds Proportions</td>
<td>Page 46</td>
</tr>
<tr>
<td>Figure 5.14: Investment Proportions</td>
<td>Page 47</td>
</tr>
<tr>
<td>Figure 6.1: Investment Proportions</td>
<td>Page 49</td>
</tr>
<tr>
<td>Figure 6.2: Scatter Graph</td>
<td>Page 50</td>
</tr>
</tbody>
</table>
## LIST OF FIGURES (continued)

<table>
<thead>
<tr>
<th>Figures</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 6.3: Efficient Frontier - Edit Series</td>
<td>50</td>
</tr>
<tr>
<td>Figure 6.4: CML - Edit Series</td>
<td>51</td>
</tr>
<tr>
<td>Figure 6.5: Required Return – Edit Series</td>
<td>52</td>
</tr>
<tr>
<td>Figure 6.6: MVP – Edit Series</td>
<td>53</td>
</tr>
<tr>
<td>Figure 6.7: Required Return and MVP Markers</td>
<td>54</td>
</tr>
<tr>
<td>Figure 6.8: Final Product</td>
<td>56</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

According to the modern portfolio theory, investors should not limit themselves to the expected risk and return of one particular stock (Francis). Investors should reduce risks through diversification because the risk in a portfolio of diverse stocks will be less than the risk of any one of the stocks. The key is diversification. Diversification is not as simple at owning ten different stocks, but to comprise assets that are relatively unrelated in order to mitigate risks. This is important when one sector performs poorly, while other sectors perform well.

In classrooms, finance students learn the principles of investment analysis and investment courses cover topics of asset management utilizing Markowitz portfolio theory, Capital Market theory, and other investment strategies. However, most of these finance courses do not provide the skills you need to build these financial models for private or professional use. There are four basic steps involved to construct optimal portfolios that offer the maximum possible expected return for a given level of risk; security valuation, performance measurement, asset allocation, and portfolio optimization (Francis). By using Excel, Visual Basics for Applications (VBA), and data from Yahoo Finance, you will be able to analyze and build an investment portfolio. This document will be helpful for those who want to expand their knowledge in finance and investments analysis by implementing these theories in Microsoft Excel.

It will take time to initially set up the spreadsheets with the desired data and entering the necessary formulas and VBA code, but once done correctly, comparing
different equity securities will be relatively simple. Excel is a superb data analysis tool. This tool allows investors to keep track of investment activities closing prices, returns, portfolio’s standard deviation, performance, and etc. Also, Yahoo Finance is a reliable source of free financial data information. It supports bulk data downloads which simplifies the task of downloading the historical financial data from finance.yahoo.com to Excel. However, a general issue with Yahoo’s financial data is that not all historical prices are available. CitiGroup (C), for example, has been trading on the New York Stock Exchange for years; however historical prices are not available before November 2013 on Yahoo. Yahoo Finance calculates the market cap using the shares outstanding from the most recently filed quarterly or annual report. Yahoo Finance does not fully cover pink sheets or preferred stocks.

This document is a hands-on approach to apply complex financial theories using Excel and VBA as a medium. The following chapters are written to be purposefully easy to understand to be suitable for anyone with a basic understanding of finance and Excel. The easy-to-follow guide will effectively walk you through the process of completing various Excel spreadsheets to develop a graphical depiction of the trade-off between risk and return for an efficient portfolio. Please note that these instructions reflect a portfolio of eight securities. When creating your own spreadsheet, you may wish to use a different number of securities and will need to select cell ranges accordingly. Also, the investment data included in this paper is for illustrative purposes to demonstrate techniques in Excel.
2. VISUAL BASICS OF APPLICATION

Visual Basic of Application (VBA) is a powerful programming tool can be used to automate repetitive tasks and develop specialized worksheet functions. It is one of the most complex features in Excel and it is easy to get overwhelmed. VBA controls excel by means of macros. A macro is a sequence of instructions that automates some aspect of Excel so that you can work more efficiently and with fewer errors. In a later chapter, you will create macros to download and format stock data from the internet. After the macro is developed, you can then execute the macro to perform many time-consuming procedures automatically. Table 2.1 is some key VBA terms (Helbaek).

Table 2.1: Definitions

<table>
<thead>
<tr>
<th>Code</th>
<th>VBA instructions that are produced in a module sheet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>One of two types of VBA macros that can be created. A function returns a single value. Functions are used in other VBA macros.</td>
</tr>
<tr>
<td>Macro</td>
<td>A set of VBA instructions performed automatically.</td>
</tr>
<tr>
<td>Method</td>
<td>An action taken on an object.</td>
</tr>
<tr>
<td>Module</td>
<td>A container for VBA code.</td>
</tr>
<tr>
<td>Object</td>
<td>An element that you manipulate with VBA. Examples include ranges, charts, drawing objects, and so on.</td>
</tr>
<tr>
<td>Procedure</td>
<td>Another name for a macro. A VBA procedure can be a Sub procedure or a Function procedure.</td>
</tr>
<tr>
<td>Property</td>
<td>A particular aspect of an object. For example, a Range object has properties, such as Height, Style, and Name.</td>
</tr>
<tr>
<td>Sub procedure</td>
<td>One of two types of Visual Basic macros that can be created.</td>
</tr>
<tr>
<td>VB Editor</td>
<td>A separate window that is used to create VBA macros.</td>
</tr>
</tbody>
</table>
Below is a quick summary of how VBA works (Jelen).

- VBA code is written in a VBA module sheet and then executed. VBA modules are stored in an Excel workbook, and a workbook can hold any number of VBA modules. To view or edit a VBA module, you must display the Developer tab.
- VBA modules consist of procedures. A procedure is the VB code that performs an action.
- VBA manipulates objects. Excel provides more than 100 classes of objects that you can manipulate. Objects include a workbook, a worksheet, and a range on a worksheet.

**Displaying Developer Tab**

In Excel 2010, the Developer tab does not appear by default. To create macros, you need want to make sure that the Developer tab is present on the Excel Ribbon. To display this tab as shown in Figure 2.1:

1. Choose File then Options.
2. In the Excel Options dialog box, select Customize Ribbon.
3. In the list box on the right, place a check mark next to Developer.
4. Click OK to return to Excel.

Figure 2.2 shows the Ribbon commands of the Developer tab. If you store one or more VBA macros in a workbook, you must save the file with an XLSM extension.
Figure 2.1: Adding Developer Tab

![Adding Developer Tab](image)

Figure 2.2: Developer Ribbon

![Developer Ribbon](image)

**VBA Reference Library**

VBA has the ability to control other applications. To write VBA code that downloads data from the internet, To add the VBA reference:

1. In the VBA application choose Tools then References.
2. In the Reference-VBAPrj ect dialog box scroll down and check Microsoft Office 14.0 Object Library as shown in figure 2.3.

Figure 2.3: Reference – VBAPrj ect Library

VBA Entering and Editing Basics

To begin, insert a VBA module in the workbook. If the workbook already has a VBA module, then use the existing module sheet for the new code.

Use the following steps to insert a new VBA module:

1. On the Developer tab click on the Visual Basic icon.

2. Choose Insert then Module. VBA inserts an empty module into the workbook.

As shown in figure 2.4, the VBA module is displayed in a separate window.
Below are some VBA coding tips (Jelen):

- After you enter a line of code, VBA evaluates that line for syntax errors. If there are no errors, then that line of code is reformatted. VBA automatically adds and removes extra spaces and recolors key words. If there is a syntax error, then the line is displayed in red and it needs to be corrected before you can execute the macro.

- A single statement can be as long as you want. However, to break the statement into two or more readable lines, insert a space followed by an underscore (_).

- To insert comments and notes into the VBA code, insert an apostrophe (‘) followed by the comments. Any text that follows a single quote is ignored.
VBA Windows

The two main windows that you should be aware of are the Project Explorer and Properties windows. The Project Explorer window shows a list of all open projects. This allows you to access and edit macros. In the Properties window, you can change the name of the modules. See figure 2.5 for an example.

Figure 2.5: Properties Window

Run Macros

As shown in Figure 2.6, to view, edit, run, or delete macros:

1. On the Developer tab, choose Macros
2. Select the macro and choose an option.
Figure 2.6: Run Macros
3. SECURITY ANALYSES

Analysts use valuation models to estimate the intrinsic values of stocks. Then they compare them to the stocks' market prices to determine whether that stock is overvalued, undervalued, or fairly valued. They will typically use more than one model with several different sets of inputs to determine stock values (Francis). This chapter will provide step-by-step instructions on how to gather key statistics that you will need to estimate the value of equities.

Financial Data Worksheet

This section will walk you through the completion of the Financial Data worksheet. To begin, start with a new Excel Workbook and rename Sheet1 “Financial Data. Enter the following headers shown in figure 3.1 in the exact cell location.

Figure 3.1: Headers

<p>| | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Next, enter the following stock tickers starting in cell A2 as show in figure 3.2. You may enter up too two hundred stock tickers.
VBA – *Stock Information Macro*

Before you begin to write the VBA code, make sure you followed the steps in adding the Developer tab and the VBA Reference as discussed in chapter 2. Refer to chapter one on how to insert a new module then type the code in figure 3.3.

Figure 3.3: Stock Information Data Download Macro

```
Sub stock_info()
    ' You can add notes after the apostrophe
    Dim Worksheet As Worksheet
    Set Worksheet = ActiveSheet

    Dim lastrow As Integer
    lastrow = Worksheet.Range("a10000").End(xlUp).Row
    If lastrow = 3 Then Exit Sub

    Dim Symbols As String
    Dim i As Integer

    For i = 3 To lastrow
        Symbols = Symbols & Worksheet.Range("a" & i).Value & "+
    Next i

    Symbols = Left(Symbols, Len(Symbols) - 1)

    Dim url As String: url = 
    "&f=snpkvm4m3j1ee9e7rp5p6r5"

    Dim http As New WinHttpRequest
    http.Open "GET", url, False
    http.Send
    Dim Response As String: Response = http.ResponseText
```
Dim lines As Variant:  lines = Split(Response, vbNewLine)
Dim sLine As String
Dim Values As Variant
For i = 0 To UBound(lines)
    sLine = lines(i)
    If InStr(sLine, ",") > 0 Then
        Values = Split(sLine, ",")
        Worksheet.Cells(i + 3, 2).Value = Split(Split(sLine, Chr(34) & "," & Chr(34))(1), Chr(34))(0)
        Worksheet.Cells(i + 3, 5).Value = Values(UBound(Values) - 13)
        Worksheet.Cells(i + 3, 6).Value = Values(UBound(Values) - 12)
        Worksheet.Cells(i + 3, 7).Value = Values(UBound(Values) - 11)
        Worksheet.Cells(i + 3, 8).Value = Values(UBound(Values) - 10)
        Worksheet.Cells(i + 3, 9).Value = Values(UBound(Values) - 9)
        Worksheet.Cells(i + 3, 10).Value = Values(UBound(Values) - 8)
        Worksheet.Cells(i + 3, 11).Value = Values(UBound(Values) - 7)
        Worksheet.Cells(i + 3, 12).Value = Values(UBound(Values) - 6)
        Worksheet.Cells(i + 3, 13).Value = Values(UBound(Values) - 5)
        Worksheet.Cells(i + 3, 14).Value = Values(UBound(Values) - 4)
        Worksheet.Cells(i + 3, 15).Value = Values(UBound(Values) - 3)
        Worksheet.Cells(i + 3, 16).Value = Values(UBound(Values) - 2)
        Worksheet.Cells(i + 3, 17).Value = Values(UBound(Values) - 1)
    End If
Next i
End Sub

After you typed the VBA code, follow the next steps to run the macro. See figure 3.4 for an example.

1. Click on the Developer Tab on your excel spreadsheet.
2. Click on Macros
3. Click “stock_info”
4. Click Run
Figure 3.4: Run the macro

![Macro dialog box showing the run button for stock_info macro]
4. STOCK PERFORMANCE

In order to analyze stock performance, we need to calculate monthly returns for individual stocks. This chapter will provide step-by-step instructions on how to download historical prices and dividends that you will need to calculate monthly returns.

Excel: Company Selection Spreadsheet

You need to setup a new worksheet before writing the next macro. Begin by renaming Sheet2, “Company Selection”. Enter the following information shown in figure 4.1 in the exact cell location. Please note: The “Begin Date” needs to be beginning of a month, while the “End Date” needs to be the ending of a month.

Figure 4.1: Company Selection Worksheet Setup
The VBA code in figure 4.2 will download all of the prices for the stocks on the ‘Financial Data’ tab and calculate monthly returns from the dates on the ‘Company Selection’ tab.

Figure 4.2: Historical Prices and Monthly Returns VBA Code

```
Sub DownloadStockDividends(ByVal stockTicker As String, ByVal StartDate As Date, ByVal EndDate As Date, ByVal DestinationCell As String, ByVal freq As String)
    Dim qurl As String
    Dim StartMonth, StartDay, StartYear, EndMonth, EndDay, EndYear As String
    StartMonth = Format(Month(StartDate) - 1, "00")
    StartDay = Format(Day(StartDate), "00")
    StartYear = Format(Year(StartDate), "00")
    EndMonth = Format(Month(EndDate) - 1, "00")
    EndDay = Format(Day(EndDate), "00")
    EndYear = Format(Year(EndDate), "00")
    qurl = "URL:http://table.finance.yahoo.com/table.csv?s=" + stockTicker + "&a=" + StartMonth + "&b=" + StartDay + "&c=" + StartYear + "&d=" + EndMonth + "&e=" + EndDay + "&f=" + EndYear + "&g=v" + "&ignore=.csv"
    On Error Resume Next
    With ActiveSheet.QueryTables.Add(Connection:=qurl, Destination:=Range(DestinationCell))
        .FieldNames = True
        .RowNumbers = False
        .FillAdjacentFormulas = False
        .PreserveFormatting = True
        .RefreshOnFileOpen = False
        .BackgroundQuery = True
        .RefreshStyle = xlInsertDeleteCells
        .SavePassword = False
        .SaveData = True
        .AdjustColumnWidth = True
        .RefreshPeriod = 0
        .WebSelectionType = xlSpecifiedTables
        .WebFormatting = xlWebFormattingNone
    End With
End Sub
```
Sub DownloadStockQuotes(ByVal stockTicker As String, ByVal StartDate As Date, ByVal EndDate As Date, ByVal DestinationCell As String, ByVal freq As String)

    Dim qurl As String
    Dim StartMonth, StartDay, StartYear, EndMonth, EndDay, EndYear As String
    StartMonth = Format(Month(StartDate) - 1, "00")
    StartDay = Format(Day(StartDate), "00")
    StartYear = Format(Year(StartDate), "00")
    EndMonth = Format(Month(EndDate) - 1, "00")
    EndDay = Format(Day(EndDate), "00")
    EndYear = Format(Year(EndDate), "00")

    qurl = "URL:http://table.finance.yahoo.com/table.csv?s=", stockTicker, "&a=&amp;a=", StartMonth, "&b=&amp;b=", StartDay, "&c=&amp;c=", StartYear, "&d=&amp;d=", EndMonth, "&e=&amp;e=", EndDay, "&f=&amp;f=", EndYear, "&g=d=", "&ignore=.csv"

    On Error Resume Next
    With ActiveSheet.QueryTables.Add(Connection:=qurl, Destination:=Range(DestinationCell))
        .FieldNames = True
        .RowNumbers = False
        .FillAdjacentFormulas = False
        .PreserveFormatting = True
        .RefreshOnFileOpen = False
        .BackgroundQuery = True
        .RefreshStyle = xlInsertDeleteCells
        .SavePassword = False
        .SaveData = True
    End With
End Sub
AdjustColumnWidth = True
RefreshPeriod = 0
WebSelectionType = xlSpecifiedTables
WebFormatting = xlWebFormattingNone
WebTables = "20"
WebPreFormattedTextToColumns = True
WebConsecutiveDelimitersAsOne = True
WebSingleBlockTextImport = False
WebDisableDateRecognition = False
WebDisableRedirections = False
Refresh BackgroundQuery:=False
End With
End Sub

Sub stock_prices()

    Dim frequency As String
    Dim numRows As Integer
    Dim lastrow As Integer
    Dim stockTicker As String

    Application.ScreenUpdating = False
    Application.DisplayAlerts = False

    Dim wsp As Worksheet ' combines all sheets on 1 tab
    For Each wsp In ActiveWorkbook.Worksheets
        If wsp.Name <> "Financial Data" And _
            wsp.Name <> "Company_Selection" Then
            wsp.Delete
        End If
    Next wsp
    Application.DisplayAlerts = True

    lastrow = ActiveSheet.Cells(Rows.Count, "a").End(xlUp).Row
    frequency = d

    'Starts to loop through stock tickers
    For Ticker = 3 To lastrow

        stockTicker = Worksheets("Financial Data").Range("$A$" & Ticker)
If stockTicker = "" Then
  GoTo NextIteration
End If

Sheets.Add After:=Sheets(Sheets.Count)
ActiveSheet.Name = stockTicker

Cells(1, 1) = "Stock Quotes for " & stockTicker

Call DownloadStockQuotes(stockTicker, Worksheets("Company Selection").Range("$b$11"), Worksheets("Company Selection").Range("$b$12"), "$a$2", frequency)
  Columns("a:a").TextToColumns Destination:=Range("a1"),
  DataType:=xlDelimited,
  Tab:=True,
  Semicolon:=False, Comma:=True, Space:=False, Other:=False,
  FieldInfo:=Array(Array(1, 1), Array(2, 1), Array(3, 1), Array(4, 1), Array(5, 1),
                     Array(6, 1), Array(7, 1)),
  Sheets(stockTicker).Columns("A:G").ColumnWidth = 10

lastrow = Sheets(stockTicker).UsedRange.Row - 2 +
Sheets(stockTicker).UsedRange.Rows.Count
If lastrow < 3 Then
  Application.DisplayAlerts = False
  Sheets(stockTicker).Delete
  GoTo NextIteration
  Application.DisplayAlerts = True
End If

SortOn:=xlSortOnValues, Order:=xlAscending, DataOption:=xlSortNormal
With Sheets(stockTicker).Sort
  .SetRange Range("A2:G" & lastrow)
  .Header = xlYes
  .MatchCase = False
  .Orientation = xlTopToBottom
  .SortMethod = xlPinYin
  .Apply
End With
'downloads dividends
Call DownloadStockDividends(stockTicker, Worksheets("Company Selection").Range("$b$11"), Worksheets("Company Selection").Range("$b$12"), "$K$2", frequency)
Columns("K:K").TextToColumns Destination:=Range("K1"), DataType:=xlDelimited, TextQualifier:=xlDoubleQuote, ConsecutiveDelimiter:=False, Tab:=True, Semicolon:=False, Comma:=True, Space:=False, Other:=False, FieldInfo:=Array(Array(1, 1), Array(2, 1), Array(3, 1), Array(4, 1), Array(5, 1), Array(6, 1), Array(7, 1))
Sheets(stockTicker).Columns("A:G").ColumnWidth = 10
If lastrow < 3 Then
    Application.DisplayAlerts = False
    Sheets(stockTicker).Delete
    GoTo NextIteration
    Application.DisplayAlerts = True
End If
With Sheets(stockTicker).Sort
    .SetRange Range("K2:L" & lastrow)
    .Header = xlYes
    .MatchCase = False
    .Orientation = xlTopToBottom
    .SortMethod = xlPinYin
End With

'Names stock dividend tables
Dim DLR As Long
DLR = Range("K5000").End(xlUp).Row
On Error Resume Next
Range("k2:L" & DLR).Name = stockTicker
Range("E1") = stockTicker
NextIteration:

Next Ticker

ErrorHandler:

Sheets.Add After:=Sheets("Company Selection")
ActiveSheet.Name = "Raw_data"

'Combines and calculates daily returns onto one sheet
Worksheets("^IXIC").Range("A2:A7000").Copy
Destination:=Worksheets("Raw_Data").Range("A2:A1000")
Dim lr As Integer
Dim CR As Integer

' combines all sheets on 1 tab
    For Each wsp In ActiveWorkbook.Worksheets
        If wsp.Name <> "Financial Data" And wsp.Name <> "Raw_data" And wsp.Name <> "Finance_Model" And wsp.Name <> "Company Selection" Then
            wsp.Activate
            lr = Range("A5000").End(xlUp).Row
            wsp.Range("E1", "E" & lr).Copy
            Worksheets("Raw_data").Activate
            With Cells(2, Columns.Count).End(xlToLeft).Offset(-1, 1)
            End With
            CR = Cells(2, Columns.Count).End(xlToLeft).Column
            With Cells(1, CR + 2)
                .Formula = "=R1C[-2]"
            End With
        End If
    Next wsp
End With
Module

Range(Cells(3, CR + 1), Cells(lr, CR + 1)).Formula = 
"=IF(ISNUMBER((VLOOKUP(RC1,INDIRECT(R1C-
1)),2,FALSE))),VLOOKUP(RC1,INDIRECT(R1C[-1]),2,FALSE),0)"

With Cells(2, CR + 2)
    .Formula = "Returns"
End With

Range(Cells(4, CR + 2), Cells(lr, CR + 2)).Formula = 
2])+1),"""")"

End If
Next wsp 'ends the merge

Cells.Select
Selection.Copy
Selection.PasteSpecial Paste:=xlPasteValues, Operation:=xlNone, SkipBlanks _
    :=False, Transpose:=False

'starts to calculate monthly returns
Application.CutCopyMode = False
Worksheets("Raw_data").Cells.Select
Selection.Copy
Sheets.Add After:=Sheets(Sheets.Count)
ActiveSheet.Name = "more_data"

Selection.PasteSpecial Paste:=xlPasteValues, Operation:=xlNone, SkipBlanks _
    :=False, Transpose:=False
Columns("A:A").Select
Application.CutCopyMode = False
Selection.NumberFormat = "m/d/yyyy"

Dim i As Integer, LC As Integer

LC = Cells(2, Columns.Count).End(xlToLeft).Column

For i = LC To 1 Step -1
    If Cells(2, i).Value = "Close" Or Cells(2, i).Value = "Div" Then _
Cells(1, i).EntireColumn.Delete xlShiftLeft
Next i

Dim rawLC As Integer
Dim rawlr As Integer

rawLC = Cells(2, Columns.Count).End(xlToLeft).Column
rawlr = Cells(Rows.Count, "A").End(xlUp).Row

Range("B2", Cells(rawlr, rawLC)).Name = "daily data"
Range("B1").Formula = ""
Range("B2").Formula = "Month/Year"
Range("B3", "B" & rawlr).Formula = ":=CONCATENATE(MONTH(RC[-1]),YEAR(RC[-1]))"

Range("C1", Cells(1, rawLC)).Copy

Sheets.Add After:=Sheets("Company selection")
ActiveSheet.Name = "MonthlyReturns"

Range("C6").PasteSpecial xlPasteValues

Range("B6").Formula = "Date"
Range("B7").Formula = "=Company selection!B11"

Range("A4").Formula = "=Company selection!B11"
Range("B4").Formula = "=Company selection!B12"
Range("c4").Formula = ":=round((RC[-1]-RC[-2])/30,0)"
Range("c4").Copy
Range("c4").PasteSpecial xlPasteValues

Dim countmonths As Long

countmonths = Range("c4").Value + 6

Range("B7").Select
    Selection.NumberFormat = "mmm-yy"
    Selection.Copy
    Selection.PasteSpecial Paste:=xlPasteValues, Operation:=xlNone, SkipBlanks _
    :=False, Transpose:=False
Range("B7").Select
Application.CutCopyMode = False
Selection.AutoFill Destination:=Range("B7", "B" & countmonths - 1),
Type:=xlFillDefault

Range("A4:C4").Clear
Range("A7").Formula = "0"

Range("C5").Formula = "2"
Range("D5", Cells(5, rawLC)).Formula = "=RC[-1] + 1"
Range("a1", Cells(1, countmonths)).Formula = "Month/Year"
Range("a2", Cells(2, countmonths)).Formula = 
"=CONCATENATE(MONTH(R3C),YEAR(R3C))"
Range("A3").Formula = "=Company_selection!B11"
Range("B3", Cells(3, countmonths)).Formula = 
"=DATE(YEAR(RC[-1]),MONTH(RC[-1])+1,DAY(RC[-1]))"

Range("C7", Cells(countmonths - 1, rawLC)).Formula = 
"=DProduct(daily_data, R5C, Offset(R1C1, 0, RC1, 2, 1)) - 1"

Range("A6", Cells(countmonths, rawLC)).Select
Selection.Copy
Selection.PasteSpecial Paste:=xlPasteValues

Range("C7", Cells(countmonths, rawLC)).NumberFormat = "0.000%"
Rows("1:5").Delete
Columns("A").Delete

Application.DisplayAlerts = False
Worksheets("more_data").Delete
Application.DisplayAlerts = True

Worksheets("MonthlyReturns").Activate

Application.DisplayAlerts = False
For Each wsp In ActiveWorkbook.Worksheets
    If wsp.Name <> "Financial Data" And wsp.Name <> "Finance_Model" And wsp.Name <> "Company_Selection"
        And wsp.Name <> "Raw_data" _
    End If
Next
And wsp.Name <> "MonthlyReturns" Then
  wsp.Delete
End If
Next wsp
Application.DisplayAlerts = True
Application.ScreenUpdating = True
End Sub

How the Macro Works

The macro loops through each stock ticker on the ‘Financial Data’ worksheet to download historical prices and dividends for the date range on the ‘Company Selection’ worksheet. Then the macro inserts a new worksheet, ‘Raw Data’, and calculates the individual stock’s daily return. Next, it uses the calculations on the ‘Raw Data’ tab to calculate the individual stocks monthly returns. The results are displayed on a new worksheet named ‘MonthlyReturns’ as shown in figure 4.3.

Figure 4.3: Monthly Returns Worksheet
5. SETUP WORKSHEETS

This chapter provides step-by-step instructions on how to setup various worksheets to complete the calculations in the next chapter.

Financial Data Worksheet

To simplify data reference, the first step is to name data ranges on the Financial Data Worksheet. The necessary steps are as followed.

1. On the Formula tab, choose Name Manager
2. In the Name Manager dialog box, choose ‘New’
3. Click on the icon to the right of the ‘Refer to:’ text box
4. Select Cells A3:Q43 and then press Enter.
5. In the ‘Name:’ text box, type ‘Fin_data’ as shown in figure 5.1.

Figure 5.1: New Name

6. Repeat steps 1 through 4 for the follow ranges:

   a. Select Cells A2:Q2 and name the range ‘titles’
b. Select Cells A4:A43 and name the range ‘stocks’

You can see where the name box is located in figure 5.2.

Figure 5.2: Name Box

Company Selection Worksheet

Complete the following headers as shown in figure 5.3.

Figure 5.3: Company Selection Headers

The next set of instructions is how to create drop down menus to select stocks.

1. Select cells “E15:I15”
   a. On the Data tab, choose Data Validation, then choose Data Validation again.
   b. In the Data Validation dialog box, select the Settings tab.
   c. On the Allow drop down menu, choose List
   d. On the Source text box, type: =stocks
e. Click OK.

f. See figure 5.4 for an example.

Figure 5.4: Drop Down Menu

2. Select cells E15:I15 and repeat steps 1a through 1c.

   a. On the Source text box, type: =titles

After you created the drop down menus, select the following headers and stocks as shown in Figure 4.5. In cell “E17” type:

“=VLOOKUP($C17,fin_data,MATCH(E$15,titles,0),FALSE)”

and drag the formula across to I17 then down to row 24. See figure 5.6 for the results.
Creating Labels with the Transpose Function

First, we want to create labels for the stocks selected on the Company Selection sheet. We want these labels to be linked to the Monthly Returns sheet rather than copied so they will automatically update whenever a new selection is made on the Company Selection sheet as shown in figure 5.7. To complete this task, we will use the TRANSPOSE function. The TRANSPOSE function is used to change data currently spread across rows, or horizontally, into columns, or vertically or vice versa. First select
the cell range BA2:BH2 on the MonthlyReturns sheet, this is where the data will be transposed to. Then type =TRANSPOSE( now click on the Company Selection sheet and select the cells containing the security selections. Type the close parenthesis, but DO NOT PRESS ENTER. To complete the process, hold down the keys ctrl+shift+enter.

Figure 5.7: Stock Labels

We want to capture appropriate return data for each stock. To accomplish this task, we will utilize the HLOOKUP function. Next, in cells AZ2:AZ49 type the numbers 2 through 49. For cell range B1:AO49 name it Returns. As shown in figure 5.8, in cell BA2 type the following formula, =HLOOKUP(BA$1,Returns,$AZ2,FALSE). It is now possible to copy the formula across and then down to capture the return data.
Figure 5.8: Capture Stock Returns

Calculation Headers

There are a few more headers to setup. In cell BA55 type =BA1 and copy it across to cell BH55. Simply type =DQ2 in cell DQ54 and then copy across to cell DZ53. Then see figure 5.9 for the rest of the headers. For cell BA61, type ‘=BA55’, then drag it across to cell BH61. Range AZ62:AZ69, type ‘=TRANSPOSE( then select the security labels in cells BA61 through BH61) and simultaneously pressing ctrl+shift+enter’.
Figure 5.9: Calculation Headers

<p>| | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>AY</td>
<td>AZ</td>
<td>BA</td>
<td>AA</td>
<td>KO</td>
<td>MSFT</td>
<td>DIS</td>
<td>IBM</td>
<td>BMY</td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Average</td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Variance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>St. Dev</td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Relative Risk</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>VCM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>66</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>67</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>68</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>69</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6. ASSET ALLOCATION

The correlation of returns between assets affects the risk of the portfolio. Risk aversion describes the investor’s tolerance for the tradeoff between risk and return. To select an optimal portfolio, analysts use investor’s tradeoff tolerance, combined with the risk and return characteristics of available portfolios (Francis). This chapter provides step-by-step instructions on how to select an optimal portfolio.

Completing Calculations

Covariance measures the extent to which two variables move together over time. A positive correlation means that the rates of returns on two stocks tend to move together (Helbaek). In Excel, we can use the COVAR function to calculate the covariance for the stocks. Go to table 6.1 and enter the following formulas. Then copy the formulas across the rows and complete the matrix. The completed matrix should resemble figure 6.1.

Table 6.1: COVAR Functions

<table>
<thead>
<tr>
<th>BA62</th>
<th>=COVAR($BA$2:$BA$49,BC$2:BC$49)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA63</td>
<td>=COVAR($BB$2:$BB$49,BC$2:BC$49)</td>
</tr>
<tr>
<td>BA64</td>
<td>=COVAR($BC$2:$BC$49,BC$2:BC$49)</td>
</tr>
<tr>
<td>BA65</td>
<td>=COVAR($BD$2:$BD$49,BC$2:BC$49)</td>
</tr>
<tr>
<td>BA66</td>
<td>=COVAR($BE$2:$BE$49,BC$2:BC$49)</td>
</tr>
<tr>
<td>BA67</td>
<td>=COVAR($BF$2:$BF$49,BC$2:BC$49)</td>
</tr>
<tr>
<td>BA68</td>
<td>=COVAR($BG$2:$BG$49,BC$2:BC$49)</td>
</tr>
<tr>
<td>BA69</td>
<td>=COVAR($BH$2:$BH$49,BC$2:BC$49)</td>
</tr>
</tbody>
</table>
Figure 6.1: Covariance Matrix

<table>
<thead>
<tr>
<th></th>
<th>VCM</th>
<th>BA</th>
<th>AA</th>
<th>KO</th>
<th>MSFT</th>
<th>DIS</th>
<th>IBM</th>
<th>BMY</th>
<th>HD</th>
</tr>
</thead>
<tbody>
<tr>
<td>61</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>BA</td>
<td>0.0044326</td>
<td>0.0024320</td>
<td>0.0012843</td>
<td>0.0016360</td>
<td>0.0019191</td>
<td>0.0006270</td>
<td>0.0012820</td>
<td>0.0015015</td>
</tr>
<tr>
<td>63</td>
<td>AA</td>
<td>0.0024320</td>
<td>0.0058247</td>
<td>0.0009622</td>
<td>0.0035494</td>
<td>0.0061110</td>
<td>0.0023512</td>
<td>0.0000180</td>
<td>0.0029917</td>
</tr>
<tr>
<td>64</td>
<td>KO</td>
<td>0.0012843</td>
<td>0.0009622</td>
<td>0.0076247</td>
<td>0.0003948</td>
<td>0.0010922</td>
<td>0.0004445</td>
<td>0.0016705</td>
<td>0.0003232</td>
</tr>
<tr>
<td>65</td>
<td>MSFT</td>
<td>0.0016360</td>
<td>0.0035494</td>
<td>0.0003948</td>
<td>0.0011772</td>
<td>0.0021406</td>
<td>0.0011086</td>
<td>0.0002632</td>
<td>0.0018376</td>
</tr>
<tr>
<td>66</td>
<td>DIS</td>
<td>0.0019191</td>
<td>0.0036110</td>
<td>0.0010922</td>
<td>0.0021406</td>
<td>0.0036544</td>
<td>0.0010143</td>
<td>0.0005737</td>
<td>0.0018209</td>
</tr>
<tr>
<td>67</td>
<td>IBM</td>
<td>0.0006270</td>
<td>0.0023512</td>
<td>0.0004445</td>
<td>0.0011086</td>
<td>0.0010143</td>
<td>0.0017229</td>
<td>0.0005976</td>
<td>0.0010378</td>
</tr>
<tr>
<td>68</td>
<td>BMY</td>
<td>0.0012830</td>
<td>0.0000180</td>
<td>0.0016705</td>
<td>0.0002632</td>
<td>0.0005737</td>
<td>0.0005976</td>
<td>0.0003046</td>
<td>0.0005358</td>
</tr>
<tr>
<td>69</td>
<td>HD</td>
<td>0.0016015</td>
<td>0.0023512</td>
<td>(0.0003232)</td>
<td>0.0018376</td>
<td>0.0018209</td>
<td>0.0013078</td>
<td>0.0005358</td>
<td>0.0034965</td>
</tr>
</tbody>
</table>

Note that the diagonal cells of the matrix represents the covariance of an asset (it’s computed against itself). These cells represent the variance for the securities. Select cells BA62: BH69 and name the range VCM.

We are now ready to complete the calculations that were labeled in the last chapter. The first calculation provides the average return for each security. In cell DQ54 type =AVERAGE(DQ3:DQ52). This captures all the returns for the first security and returns the average figure. Next, we have to calculate variance and standard deviation. Variance and standard deviation of returns are common measures of investment risk. The variance for each security has already been calculated in the VCM matrix. So you need to reference the appropriate cell. In cell BA57, type =BA62. This should correspond to the cell in the VCM matrix where the covariance for the security in column BA is computed against itself. In cell BB57, type =BB63. Repeat this process until the variance for each security has been linked to the variance calculation for that security in the VCM matrix. Standard Deviation is calculated by obtaining the square root of the variance. In cell BA58, type =SQRT(BA57). Then copy it across. Relative risk is
calculated by dividing the standard deviation of the security by the security average return. In cell BA59, type =BA58/BA56. Then copy it across. The results are shown in figure 6.2.

Figure 6.2: Calculations

<table>
<thead>
<tr>
<th></th>
<th>BA</th>
<th>AA</th>
<th>KO</th>
<th>MSFT</th>
<th>DIS</th>
<th>IBM</th>
<th>BMY</th>
<th>HD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>0.023934715</td>
<td>-0.003536938</td>
<td>0.002831619</td>
<td>0.010240046</td>
<td>0.0022365086</td>
<td>0.01263562</td>
<td>0.019573711</td>
<td>0.027095035</td>
</tr>
<tr>
<td>Variance</td>
<td>0.0044126</td>
<td>0.0098247</td>
<td>0.00176247</td>
<td>0.0041772</td>
<td>0.0036944</td>
<td>0.0017229</td>
<td>0.00334066</td>
<td>0.0034965</td>
</tr>
<tr>
<td>St. Dev</td>
<td>0.066578042</td>
<td>0.099119724</td>
<td>0.087319726</td>
<td>0.0646313</td>
<td>0.060451544</td>
<td>0.041507247</td>
<td>0.055196452</td>
<td>0.059131489</td>
</tr>
<tr>
<td>Relative Risk</td>
<td>2.902934712</td>
<td>-280.0249509</td>
<td>36.83738338</td>
<td>63.1622254</td>
<td>2.702942618</td>
<td>3.284939541</td>
<td>2.819927783</td>
<td>2.182373883</td>
</tr>
</tbody>
</table>

**Directions for Completing the Matrix Worksheet**

This spreadsheet will obtain data from the ‘MonthlyReturns’ spreadsheet and information calculated on this spreadsheet will be linked to the Company Selection.

Please note that this example uses an eight security portfolio. If your portfolio contains fewer/more securities, the exact cell placement and range selections will need to be adjusted accordingly. Insert a new sheet and name it Matrix.

On the Matrix sheet, in cell B3, type VCM. To link the VCM matrix created on the MonthlyReturns sheet to the Matrix sheet, select range C4:J11, type =VCM, then simultaneously press \textit{ctrl+shift+enter}. If you have ten securities you need to highlight ten columns across and ten columns, then type in the formula. Now the matrix is dynamically linked so that as alternative securities are selected, this matrix will automatically update.

Select cells R4:Y11, type =vcm, then press \textit{ctrl+shift+enter}. Directly below the data, type the number 1 in each cell (cells R12:Y12). Also, directly to the right of the
data, type the number 1 in each cell (cells Z4:Z11). Then, finally cell Z12 type 0. See figure 6.3 for an example.

Figure 6.3: VCM Matrix

Now we can calculate the Minimum Variance Portfolio proportions. The next step is to create the inverse of the VCM matrix. Notice that VCM matrix is 9x9, so you have to select 9 rows and 9 columns starting with cell R15. Type =MINVERSE(R4:Z12) and simultaneously press `ctrl+shift+enter`. Figure 6.4 is an example of the completed matrix. Notice that cell Z23 is the Variance of the portfolio, while the shaded cells are the stock proportions to invest.
Figure 6.4: Minimum Variance Proportions

See Table 6.2 to calculate the variance, standard deviation, and the return for the Minimum Variance Portfolio. Please note that the R(p) calculation is multiplying the averages on the Monthly Returns sheet with the stock proportions. See figure 6.5 for results.

Table 6.2: Portfolio Calculations

<table>
<thead>
<tr>
<th>Q</th>
<th>R</th>
<th>S</th>
<th>T</th>
<th>U</th>
<th>V</th>
<th>W</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
<td>32</td>
<td>33</td>
</tr>
</tbody>
</table>

In Cell Z25 type ‘=Z23’
In Cell Z26 type ‘=SQRT(Z25)’
In Cell Z27 type ‘=MMULT(MonthlyReturns!BA56:BH56,Matrix!Z15:Z22)’ then simultaneously press ctrl+shift+enter’
The next step is to create the Border Hessian Matrix (BHM). In cell B16, type BHM. Select cells C17:J24, note that this selection is an 8x8 matrix. Type =2*VCM and then simultaneously press ctrl+shift+enter. Directly below the data, type the number 1 in each cell (cells C25:J25). In the next row (cells C26:L26), link the average returns from the MonthlyReturns sheet. In cell C26, type =MonthlyReturns!BA56, then copy it across.

Next, we will use the TRANSPOSE function to copy and paste the data from cells C25:J26 needs to be copied to cells K17:L24. Select cells K17:L24, type =TRANSPOSE(C25:J26) and press ctrl+shift+enter. Finally, enter a zero in the last four cells of the matrix (M27:N28). See figure 6.6 for a completed BHM matrix.
The next step is to create the inverse of the BHM matrix. In cell B33, type $\text{BHM}^{-1}$.

Notice, as shown in figure 6.7, that BHM matrix is 10x10, so you have to select 10 rows and 10 columns starting with cell B34. Type $=\text{MINVERSE(C17:N26)}$ and simultaneously press $\text{ctrl+shift+enter}$. Figure 6.8 is an example of the completed matrix.
Figure 6.7: $\text{BHM}^1$ Matrix Setup

![Excel Sheet Image]

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>BHM</td>
<td>0.008805</td>
<td>0.004864</td>
<td>0.002599</td>
<td>0.003272</td>
<td>0.003838</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
<td>0.003272</td>
<td>0.003838</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>0.002599</td>
<td>0.002599</td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
<td>0.003272</td>
<td>0.003838</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>0.003272</td>
<td>0.003272</td>
<td>0.003272</td>
<td>0.003272</td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
<td>0.003272</td>
<td>0.003838</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>0.003838</td>
<td>0.003838</td>
<td>0.003838</td>
<td>0.003838</td>
<td>0.003838</td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
<td>0.003272</td>
<td>0.003272</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>0.00722</td>
<td>0.00722</td>
<td>0.00722</td>
<td>0.00722</td>
<td>0.00722</td>
<td>0.00722</td>
<td>0.00722</td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
<td>0.003272</td>
<td>0.003838</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
<td>0.003272</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.004864</td>
<td>0.008805</td>
<td>0.002599</td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.004864</td>
<td>0.008805</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.004864</td>
</tr>
<tr>
<td>26</td>
<td></td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>27</td>
<td></td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
<td>0.000722</td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![](https://example.com/excel-screenshot.png)
Investment Proportion Calculations

The purpose of the next two spreadsheets will be to find the proportion that should be invested in each of the chosen stocks and the bond in order to achieve the chosen required rate of return. These sheets will calculate the following:

1) Standard deviations for the portfolio
2) Portfolio returns.
3) The proportion that should be invested in the bond.
4) The proportion that should be invested in each stock
5) Create a table which searches all of this data for the proportions invested in each stock and the bond that will give the investor their chosen required rate of return.

Equity Worksheet

Insert a new worksheet and name it Equity. Enter the following headers as shown in figure 6.9. In cells D2:K2 type ‘=TRANSPOSE(Company Selection!C17:C24) and

<table>
<thead>
<tr>
<th>BHM⁻¹</th>
<th>170.8416</th>
<th>0.220857</th>
<th>-6.91159</th>
<th>-16.2488</th>
<th>-62.5489</th>
<th>34.62945</th>
<th>-63.9272</th>
<th>-56.0554</th>
<th>-0.0566</th>
<th>6.632886</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.220857</td>
<td>68.22153</td>
<td>-21.9231</td>
<td>-50.7729</td>
<td>-0.31586</td>
<td>-77.2957</td>
<td>55.33327</td>
<td>26.53194</td>
<td>0.198396</td>
<td>-19.1225</td>
</tr>
<tr>
<td></td>
<td>-62.5489</td>
<td>-0.31586</td>
<td>-5.54515</td>
<td>-26.3639</td>
<td>221.0742</td>
<td>-9.52231</td>
<td>-7.86754</td>
<td>-108.91</td>
<td>-0.31404</td>
<td>21.934</td>
</tr>
<tr>
<td></td>
<td>34.62945</td>
<td>-77.2957</td>
<td>-27.1266</td>
<td>-69.8422</td>
<td>-9.52231</td>
<td>358.8259</td>
<td>-140.326</td>
<td>-67.3424</td>
<td>0.675166</td>
<td>-6.24116</td>
</tr>
<tr>
<td></td>
<td>-63.9272</td>
<td>55.33327</td>
<td>-49.6231</td>
<td>5.93006</td>
<td>-7.86754</td>
<td>-140.326</td>
<td>231.5177</td>
<td>-31.0368</td>
<td>0.168905</td>
<td>-2.03853</td>
</tr>
<tr>
<td></td>
<td>-0.0566</td>
<td>0.198396</td>
<td>0.248612</td>
<td>0.34004</td>
<td>-0.31404</td>
<td>0.675166</td>
<td>0.168905</td>
<td>-0.25648</td>
<td>0.00533</td>
<td>0.168668</td>
</tr>
</tbody>
</table>
In cells S1:Z2 type ‘=TRANSPOSE(Matrix!K34:L41)” and press \textit{ctrl+shift+enter}.

Figure 6.9: Equity Worksheet Headers

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>1</td>
<td>R(p)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Slope</td>
<td></td>
<td>Variance</td>
<td>STD</td>
<td>R(p)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R(p)</th>
</tr>
</thead>
</table>

The remaining calculations are as follows. See figure 6.10 for an example of what the worksheet should look like.

1. Cells B3:B162: 1

2. Cells C3: 0
   a. C4: .001
   b. Select C3:C4 and drag it to C162.

3. Cells D3:K162: =MMULT(B3:C162,S1:Z2)

   a. Drag the formula down to L162.

5. Cells M3: =SQRT(L3)
   a. Drag the formula down to M162.

6. Cells N3: =C3
   a. Drag the formula down to C162.

7. Cell A3: =(C3-rf)/M3
   a. Drag the formula down to A162.
8. Name cell range A3:M162: Slope

Figure 6.10: Equity Sheet Calculations

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Slope 1</td>
<td>Risk</td>
<td>AA</td>
<td>KO</td>
<td>MFT</td>
<td>DS</td>
<td>IBM</td>
<td>BNY</td>
<td>HD</td>
<td>Var</td>
<td>HD</td>
<td>Var</td>
<td>HD</td>
</tr>
<tr>
<td>2</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>3</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>4</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>5</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>6</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>7</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>8</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>9</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
<tr>
<td>10</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
<td>0.0038</td>
</tr>
</tbody>
</table>

Note: The table above represents the equity sheet calculations with columns labeled as follows: Column A: Slope, Column B: Risk, and Columns C to M: Specific company codes (AA, KO, MFT, DS, IBM, BNY, HD, Var). The variance and standard deviation (HD Var) are also included.
Next, we need to find the maximum slope of the portfolio as shown in Figure 6.11.

The steps are as follow.

1. Cell A164 type ‘Max Slope’.
2. Cell A165 type ‘=MAX(A3:A162)’
3. Name cell A165: max_slope
4. Cell C164 type ‘RM’
5. Cell D164 type ‘=D2’, then drag across to cell N164.
6. Number cells A167:N167: 1 to 14
7. Cell C165 type ‘=VLOOKUP($A$165,slope,C167,False)’ then drag the formula across to cell N165.
8. Name cell C165: RM

Figure 6.11: Maximum Slope
Stocks and Bonds Worksheet

Insert a new worksheet and name it “Stocks and Bonds”. Enter the headers that shown in figure 6.12. In range D2:K2: =TRANSPOSE(Company_Selection!C17:C24) and press ctrl+shift+enter. In cell L3 type ‘0’ and in cell L4 type ‘.001’. Select range L2:L3 and drag it down to cell 83.

Now enter the following calculations.

1. Cell B3: =rf+max_slope*L3
2. Cell C3: =(B3-RM)/(rf-RM)
3. Cell D3: =\((1-\$C3)\times\text{Equity!D}$165
   a. Drag the cell across to cell K3
4. Select cell range B3:K3 and drag it down to row 83
5. Name cell range B3:L83 “stock_bond”

Figure 6.12: Stocks and Bonds Calculations

The last step is to find the proportions to invest in based on the required rate of return that you identified on the Company Selection worksheet and link the results to the ‘Company Selection’ worksheet. See figure 6.13 for the proportions to invest.
Enter the following in the corresponding cells.

1. Cell C86: =C2 then drag across to cell L86

2. Cell A87: Required Return

3. Cell B87: =RQ

4. Number cells C89:L89 2 to 11

5. Cell C87: =VLOOKUP(rq,stock_bond,C89,TRUE)
   a. Drag the cell across to L87

Figure 613: Stocks and Bonds Proportions

Finally, we will link the Stocks and Bonds worksheet to the Company Selection worksheet. On the Company Selection worksheet select range D16:D24 and type

=TRANSPOSE('Stocks and Bonds'!C87:K87) ctrl+shift+enter. Then in cell B3 type

='Stocks and Bonds'!L87. See figure 6.14 for the final product.
<table>
<thead>
<tr>
<th>Security</th>
<th>Volume</th>
<th>P/E</th>
<th>Price/Book</th>
<th>Previous Price</th>
<th>% Invest</th>
<th>Company Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HD</td>
<td>725.72</td>
<td>2.19</td>
<td>6</td>
<td>7.19</td>
<td>77.5</td>
<td>Home Depot Inc.</td>
</tr>
<tr>
<td>MRK</td>
<td>229.22</td>
<td>2.32</td>
<td>6.99</td>
<td>22.94</td>
<td>114.8</td>
<td>Nicer &amp; Company</td>
</tr>
<tr>
<td>IBM</td>
<td>151.25</td>
<td>3.02</td>
<td>4.54</td>
<td>18.21</td>
<td>4.57</td>
<td>International Bus</td>
</tr>
<tr>
<td>DIS</td>
<td>0.182</td>
<td>3.85</td>
<td>3.52</td>
<td>20.88</td>
<td>6.82</td>
<td>Walt Disney Company</td>
</tr>
<tr>
<td>MSFT</td>
<td>3.79</td>
<td>3.82</td>
<td>1.32</td>
<td>5.25</td>
<td>4.47</td>
<td>Apple Inc.</td>
</tr>
<tr>
<td>KO</td>
<td>3.09</td>
<td>2.79</td>
<td>3.04</td>
<td>18.31</td>
<td>8.35</td>
<td>P&amp;G Company</td>
</tr>
<tr>
<td>MCD</td>
<td>0.173</td>
<td>4.65</td>
<td>6.33</td>
<td>9.65</td>
<td>1.79</td>
<td>McDonald's Corp</td>
</tr>
<tr>
<td>BA</td>
<td>0.197</td>
<td>1.79</td>
<td>2.08</td>
<td>17.87</td>
<td>9.05</td>
<td>Southwest Airline</td>
</tr>
<tr>
<td>DIA</td>
<td>0.585</td>
<td>2.22</td>
<td>0.01</td>
<td>0.02</td>
<td>57.4</td>
<td>Smith &amp; Wesson</td>
</tr>
</tbody>
</table>

Figure 6.14: Investment Proportions
7. OPTIMAL PORTFOLIO

For each level of expected return, we can vary the portfolio weights on the individual assets to determine the portfolio with the east risk. These portfolios have a lowest standard deviation of all portfolios with a given expected return are known as the minimum variance portfolio. Typically, investors prefer the portfolio that has the greatest expected return when choosing a portfolio with the same standard deviation. The portfolios that have the greatest returns for each level of risks make up the efficient frontier. Portfolios that are not on the efficient frontier have lower returns than an efficient portfolio with the same amount of risk (Francis). This section will walk you through on how to graph the investment proportions, Efficient Frontier Graph and find the minimum variance portfolio.

Investment Proportions Chart

On the Company Selection worksheet, select Cells C15:D24 then click on the Insert tab in the ribbon and click on the column chart. Select the Clustered Column chart, the bar chart appears, and then move the chart to the desired location. You can adjust the size and format the chart to your liking. See figure 7.1 for an example.
Creating the efficient frontier graph

The next graph you will make will include the Efficient Frontier curve, the Capital Market Line (CML), the Required Rate coordinate on the CML, and the Minimum Variance Portfolio (MVP) coordinate on the Efficient Frontier curve. First click on the Insert tab on the ribbon and click on Scatter, then click on the Scatter with Smooth Lines graph (see figure 7.2).
Figure 7.2: Scatter Graph

To graph the Efficient Frontier, see figure 7.3 and follow the instructions below.

1. Next right click on the new graph and click on Select Data click on Add.
2. In the Edit Series dialogue box
   a. Series name: Efficient Frontier,
   b. Series X values: =Equity!$M$3:$M$60
   c. Series Y =Equity!$N$3:$N$60.
   d. OK

Figure 7.3: Efficient Frontier - Edit Series
Please note, that you are selecting standard deviation values for X and return of the portfolio values for Y.

To graph the CML, see figure 7.4 and follow the instructions below.

1. Right click on the new graph and click on Select Data click on Add.

2. In the Edit Series dialogue box
   a. Series name: CML
   b. Series X values: ='Stocks and Bonds'!$L$3:$L$83
   c. Series Y ='Stocks and Bonds'!$B$3:$B$83
   d. OK

Figure 7.4: CML - Edit Series

To graph the Required Return, see figure 7.5 and follow the instructions below:

1. Right click on the new graph and click on Select Data click on Add.

2. In the Edit Series dialogue box
   a. Series name: Required Return
   b. Series X values: =Company_Selection!$B$3
c. Series Y = Company_Selection!$B$2

d. OK

Figure 7.5: Required Return – Edit Series

Please note that this point represents the risk and return coordinate on the CML for your portfolio.

To graph the MVP, see figure 7.6 and the step are as follows:

1. Right click on the new graph and click on Select Data click on Add.

2. In the Edit Series dialogue box

   a. Series name: MVP

   b. Series X values: = Matrix!$Z$26

   c. Series Y: = Matrix!$Z$27

   d. OK
Figure 7.6: MVP – Edit Series

![Edit Series dialog box](image.png)

Note: This point will represent the risk and return coordinate on the Efficient Frontier of the portfolio with the minimum variance. Also, to make the MVP and Required Rate coordinates stand out, click on the CML so it is selected. Press the up arrow. This will selected the Required Rate coordinate, then right click on it, go to Format the Data Series, go to Marker Options and check Built-in. Repeat this technique and format the MVP. See figure 7.7 below.
Figure 7.7: Required Return and MVP Markers
Conclusion

The Company Selection sheet should look like the figure 7.8 below. You should be able to change companies, required rate of return, and the risk free rate and the graph should automatically update. The final product is a graphical depiction of the trade-off between risk and return for an efficient portfolio.
Figure 7.8: Final Product
Work Cited

